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Overview

SDRuno is an advanced Software Defined Radio Application platform which is optimized for use with
SDRplay's range of Radio Spectrum Processors. This means that the specific features of a particular
SDRplay RSP receiver model are enabled automatically within SDRuno. In this update to the manual, we
have included screenshots for both the RSP1 and RSP2/RSP2pro to illustrate how those features present
themselves and can be enabled and controlled.
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1. Installation

Download the SDRuno installer from the Windows section of the website
(http://www.sdrplay.com/downloads/) which is shown below.

Home StartHere Products Reviews Purchase Downloads Community Blog Distribulors  Contact
SO i
SOFTWARE DOCUMENTATION
& Windows A Linux x86 & Mac & Raspberry Pi A Software (A App Notes [ Community Media % Links
# Android A ARM64

SDRUNO USER MANUAL
¥ SDRUNO - VERSION 1.13 (version 1.13/ 15th March 2017)

(RSP1/RSP2) Includes hardware driver
SDRUNO RELEASE NOTES

HDSDR - VERSION 2.76 (version 1.13/ 15th March 2017)

(RSP1/RSP2) Includes hardware driver/API/EXTIO plugin

[«

API| SPECIFICATION

¥ EXTIO PLUGINS - VERSION 1.0 (version 2.09 / 23rd December 2016)
(RSP1/RSP2) Includes hardware driver/AP|
API RELEASE NOTES

SDR-CONSOLE - V2.3 2760 (version 2.09 / 23rd December 2016)
(RSP1/RSP2) Includes hardware driver/AP|

[«

ADS-B USER GUIDE

¥ SDR-CONSOLE - V3.0 PREVIEW 5A (version 1.3/ 1st October 2016)
(RSP1/RSP2) Includes hardware driver/AP|

¥ API/HARDWARE DRIVER - VERSION 2.09

(RSP1/RSP2) For developers only

Temporarily disable your Antivirus software to allow the installation to install uninterrupted
Run the downloaded installation file and you will see this, click Yes to continue.

) User Account Control X

5 Do you wantto allow this app to make changes to your

PC?

Program name:  SDRplay's SDRuno Setup

i
‘h}-“ Verified publisher: SDRplay Limited
File origin: Hard drive on this computer
() Show details ves | [ o

Change when these notifications appear

R1.13 Copyright © 2017 SDRplay Limited 6
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Please read and accept the license agreement.

=ja Setup - SDRplay's S0Runo

License Agreement
Please read the following important information before continuing.

Flease read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

BDRplay Limited A
EMD USER. LICENCE AGREEMENT

The SDRplay software ("Product”) you are about to install, run and/for use is
licensed by SDRplay Limited, a company reqgistered in England (Mo, 09035244),
whose reqgistered office is 6 Thornes Office Park, Monkton Road WAKEFIELD WF2
7AMN UK SDRplay™), and is subject to the following licence terms ("Licence™).

“fou” {or "Your™) shall mean an individual or Legal Entity exerdising permissions
granted by this License,

By proceeding to install, run andjor use the Product, you confirm that you accept ¥

OI accept the agreement
(@)1 do not accept the agreement

< Back Mext = Cancel

The next screen will displayimportantinformation. Read and then click Next.

= Setup - S0Runc

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

PLEASE MAKE SURE NO RSPs ARE NOT CONNECTED TO THE MACHINE BEFORE
CONTINUING

R1.13 Copyright © 2017 SDRplay Limited
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The next screen shows the installation directory. Check you have enough disk space and then click Next

=fa Setup - SDRplay's SDRunc —

Select Destination Location
Where should SDRplay's SDRUND be installed?

Setup will install SDRplay's SDRUno into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

": ogram Files (x86)\SDRplay\sDRUNo Browse...

At least 23, 1 MB of free disk space is required.

The next screen allows the Start Menu folder to be changed if needed.

T Setup - SDRunc -

Select Start Menu Folder
Where should Setup place the program's shorbouts?

Setup will create the program's shortcuts in the following Start Menu folder.

To continue, click Next. If you would like to select a different folder, dick Browse.

av\SDRUNG Browse...

<o o> | come

R1.13 Copyright © 2017 SDRplay Limited 8
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The next screen confirms where the software will be installed to. If correct, click Install.

= Setup - SDRunc —

Ready to Install
Setup is now ready to beain installing SDRuno on your computer.

et
™~

Click Install to continue with the installation, or dick Back if wvou want to review or
change any settings.

[ Destination location:
C:\Program Files (x86)\SDRplay\SDRuno

Start Menu folder:
SDRplay\SDRuno

<ok conce

Check the next window for important information about installing the hardware drivers.

== Setup - SDRunc —

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

[CONNECT YOUR RSP AND ALLOW DRIVER INSTALL TO COMPLETE BEFORE
STARTING SDRUNO

R1.13 Copyright © 2017 SDRplay Limited 9
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This completes the installation; clicking Finish will close the installer and optionally start SDRuno.

=}a Setup - SDRplay's SDRunc -

Completing the SDRplay's SDRuno
Setup Wizard

Setup has finished installing SDRplay's SDRUNo on your
computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

Launch SDRplay's SDRUND

SDRuno getting started video guides

Guide for the RSP-1
You Tuhe https://youtu.be/xBGHBOOMXHU

Guide for the RSP-2
https://youtu.be/92Iljh NAEfc

DO NOT directly connect an RSP to the same antenna as your transmitter, or
to an antennain the near field of a transmitting antenna, as this is likely to
(( )) result in irreversible damage to your RSP.

R1.13 Copyright © 2017 SDRplay Limited 10
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2. Basics and Concepts

2.1 Applicationinstance
s wa o= x| ==

=X

Final SR: 2000000 Final SR: 2000000
IFBW: 1.536MHz (ZIF) IFBW: 1.536MHz (ZIF)
0 =@ 0 =@

GR: dB

ADD VRX

-3
SR (MHz) DEC B SR (MHz) DEC = L0 LOCK

IF Gain

RF Gain
Reduction (7] RGN resuction
Sys: 2%

4/11/2017 9:09:36 AM SDRplay RSP-1 4/11/2017 9:09:36 AM

SDRplay RSP-2

SDRuno can run in multiple instances, each with a different input device. The default input device is the
SDRplay RSP but the input device can also be a soundcard (WME or ASIO), a pre-recorded IQ file or an

external SDR receiving hardware (as Perseus, SDR-14, QS1R etc.) via ExtlO dll interface. Each SDRuno
instance stores and recalls its own settings.

Please note: closing the instance #0 will close all the other instances as well.

2.2 Mainwindow

T Tx] = T=Tx

REC PANEL Final SR: 2000000 REC PANEL Final SR: 2000000
IFBW: 1.536MHz (ZIF) i IFBW: 1.536MHz (ZIF)
0 C= 0 e :

SR (MHz) DEC bl SR (MHz) DEC

Sys: 2%

4/11/2017 9:09:36 AM SDRplay RSP-1 4/11/2017 9:09:36 AM

(Left: RSP-1 Right: RSP-2/2PRO
(RSP2/RSP2pro has antenna port and MW/FM notch filter selection options)

SDRplay RSP-2

The first time you run SDRuno only this window is shown. The main window is the control centre of a
SDRuno instance. Here you can open the VRX windows, enable/disable VRX, create and manage
workspaces, change the instance settings, select the input source and sample rate (where applicable),
open the recorder window etc. It can be closed or minimized to the task bar.

2.3 Virtual Receiver (VRX)

X oo v T=Tx

Final SR: 2000000 Final SR: 2000000
IFBW: 1.536MHz (ZIF) IFBW: 1.536MHz (ZIF)
0 C=E 0 C= @

GR: dB GR: dB

SR (MHz)  DEC sl SR (MHz)  DEC

] e vorer e
Sdr: 0%

4/11/2017 9:09:36 AM SDRplay RSP-1 4/11/2017 9:09:36 AM

SDRplay RSP-2

A VRX is a receiver implemented in software; each VRX takes the signal from the input device, processes
it and outputs the demodulated signal to an output device of your choice (currently only WME devices are
supported). For the RSP, SDRuno can create and run multiple VRX inside the same application instance.

When you run an instance of SDRuno, one VRX is always created: it is the “master’” VRX or VRX #0. VRX
#0 has some peculiarities:

R1.13 Copyright © 2017 SDRplay Limited 11
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- can’t be disabled or deleted
it is the only VRX that can change the LO of the external hardware

itis (currently) the only working VRX when using the ASIO driver

SETT. SDRuno MAIN =

Final SR: 2000000 Final SR: 2000000

IFBW: 1.536MHz (ZIF)

IFBW: 1.526MHz (ZIF)
0 =] GR: dB

GR: dB

SR (MHz) DEC

SR (MHz) DEC
] | |-
o [z -

Reduction
Sys: 2% Sys: 2%

4/11/2017 9:09:36 AM SDRplay RSP-1 4/11/2017 9:09:36 AM SDRplay RSP-2

(Left: RSP-1 Right: RSP-2/2PRO)

A VRX includes four windows: SP1, SP2, RX Control & RX EX Control.

S 4/11/2017 9:22:00 A

SP1 is the “main spectrum” window: it shows the spectrum of the signal from the input device. This
window is resizable and its settings are stored and recalled together with the relative VRX Also it can be
closed or minimized to the task bar.

Ol= x| s |m T=1x

Final SR: 2000000
IFBW: 1.536MHz (ZIF)

05 00I= x| N
Span 24 KHz FFT 632 Pts RBW 18.96 Hz Marks 200 Hz Final SR: 2000000

EOEEIR T e EFOEEID

4000
SR (MHz)

(o] I 20 ]

4/11/2017 9:19:03 AM SDRplay RSP-1 4/11/2017 9:19:03 AM SDRplay RSP-2

SP2 or “Aux spectrum” window: it shows the spectrum in the down-converted bandwidth.
Here you can modify the selectivity filter, place notches etc.
This window is resizable and its settings are stored and recalled together with the relative VRX

Also it can be closed or minimized to the task bar.

|- Ex= =D T ToT=
Final SR: 2000000 Final SR: 2000000

IFBW: 1.526MHz (ZIF)

IFBW: 1.536MHz (ZIF)
0 [ [Cerm] (o] : 0 [(on] [Feem | e 0 fman

B
T . . Kl sromo  oxc
[warc) W] veor | - [ | W[ 20 ][ 1] o - R‘&m
p b uction MW/FM NOTCH uction
- - = - (o) COm o5
ool [ | (557 [ g e ———— 3 =
[ I — | 2, Clear Enter 471172017 9:26:16 AM SDRplay RSP-1 4/11/2017 9:26:17 AM SDRplay RSP-2

mooe | o e e | T e e

vFO FM MODE N8 NOTCH 5 9
160 80 40 DEL Vi

cwor _sw
IEERIEETEE] cooo | ==
P S r— sequs)  DEC T

PLAY!

RX Control is the VRX control center: here you can set the VRX output device, frequency, receiving
mode and many more parameters. Its settings are stored and recalled together with the relative VRX and

it can be closed or minimized to the task bar.
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VFO - QM FM MODE CwW OP FILTER NB NOTCH

XN [ 5 | ML [ | [ [omo | [ [oow ] [mom ] 160, .80, .40

30 20 17
e i e
15 12_ || 10
———

2 Clear Enter

RX EX Control groups additional controls for the VRX that are (generally) less frequently used. The
purpose of this separation is to spare screen space when possible. Here you hawe access to all the
parameters relative to notches, noise blanker, noise reduction, soft filter, SNR and more. These settings
are stored and recalled together with the relative VRX and it can be closed or minimized to the task bar.

Note: Each VRX stores and recall its own settings.

R1.13 Copyright © 2017 SDRplay Limited 13
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2.4 Workspaces
N

SDRplay RSP-1

<l e ==

Waksiisca Final S%: 2000000

IFBW: 1.536MHz (ZIF)

cculaznnwm [l  voroce2 o (== =10 S
Workspace 3 E
Workspace 4 S:

SR(MHz) D Workspace 5 SR (MHz)  DEC | E
(o] I 20 ] [ [ Il
RF Gai:
Workspace 7 [mz] Reduction
Sys: 2 Workspace 8 Sys: 2%

4/11/2017 9:32:45 AM Workspace 9 4/11/2017 9:32:45 AM SDRplay RSP-2

In SDRuno a workspace is a data set of vsibility information (position, size and show/hide status) relative
to all the VRX, Main and Recorder windows used in an instance. The RDS Info window parameters of
each VRX are also sawed. Ten workspace memory positions are available in each instance (0 — 9). A
workspace can be renamed. The first time you run SDRuno, the workspace #0 is recalled; its default
name is “Default Workspace”. The last used workspace in a given instance is stored at program exit and
recalled at the next start-up.

3. Getting Started

Here is some information on how to get up and running quickly with SDRuno.
3.1 Creatingaworkspace

Once you hawe started SDRuno you can try building a simple test workspace to practice with the
operations inwlved. Each VRX has a corresponding row of buttons in the main window. From left to right
you have:

- the VRX number

- the SP1 button (shows the Main Spectrum window of that VRX)
- the SP2 button (shows the Aux Spectrum window of that VRX)

- the RX button (shows the RX Control window of that VRX)

- the VRX enable/disable button (a small squared coloured button)

— - x = = D T
Final SR: 2000000 Final SR: 2000000

IFBW: 1.526MHz (ZIF)

G B e e () i

IFBW: 1.536MHz (ZIF)

| ()

B
SR (MHz) DEC SR (MHz) DEC =
[ acc | b
uction [T Requetion
Sys: 2% Sys: 1%

4/11/2017 9:26:16 AM SDRplay RSP-1 4/11/2017 9:26:17 AM SDRplay RSP-2

Since we have not created another VRX, only the VRX #0 row will be available. Left-click the SP1 button:
the SP1 window will appear, with the default size and position. Now try to resize it: it can be done
grabbing a border edge and dragging (as in usual Windows resize operations) or clicking and dragging the
small button in the left-bottom corner of the window. Right-clicking on that button will pop up a small
preset menu where you can select among some common screen widths. Mowve the window clicking on the
border (or any other part of the window outside of a control) and dragging.

Now repeat the abowve operation for SP2 then click RX to open the RX Control window and mowe it to a

suitable position. If you wish you can also add the RX EX Control to your workspace: to show it click on
the EXW button on the RX Control window. Once you are satisfied with your work you can sawe the

R1.13 Copyright © 2017 SDRplay Limited 14
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workspace: click on the workspace name label in the main window (the label that is currently showing
“Default Workspace”), the workspace selection will popup. To store your workspace in one of the ten
positions available click on one of these while pressing the CTRL key.

3.2 ManagingWorkspaces

sen wa TRy 4| =2 =1

SDRplay RSP-1
o FOEI 0 [ o (=] =] =10

Workspace 3 ‘ E

IFBW: 1.536MHz (ZIF)

Workspace 4 N
SR (MHz) D Workspace 5 SR (MHz) DEC ‘ =
(o) IS 20 [ [ 755 I [
RF Gain
ioncnd e
Sys: 2 Workspace 8 Sys: 2%

4/11/2017 9:32:45 AM Workspace 9 4/11/2017 9:32:45 AM SDRplay RSP-2

In order to manage workspaces you have the following options:

Save the current windows set to a workspace memory position: popup the workspace menu and Left-Click
to a workspace name while pressing the CTRL key.

Recall a workspace (making it the current workspace): popup the workspace menu and Left-Click to a
workspace name.

Rename the current workspace: Right-Click on the workspace name label in the main window, enter the
new name then press Enter to confirm or ESC to abort.

3.3 Selectinganinputsource

Main Settings - AIN 3] = e
=
IUCN | CAL | OFFSET | TMATE | ORIG

Final SR: 2000000

WME Input Device RSP2 Ready IFBW: 1.536MHz (ZIF)

> 0 (] [Eeear| [Emc] S s

Line 1 (Virtual Audio Cable)
Line In (2- Scarlett 2i2 USB)

Microphone (3- USB Audio Panel SR (MHz)
Input Level Display  Gain Reduction |§d . -
[z ot

IF Mode Zero-IF n [ — -1

DEC

B 0 |sys:8%

IF AGC ¥
acc @ 4/5/2017 11:09:01 PM RSP2 Pro

The default input device is the SDRplay RSP. If there is no available RSP, either none are connected or
all connected RSPs are in use, SDRuno will load an ExtlO dIl from the SDRuno folder and as long as the
relative hardware is connected and ready. This then becomes the default input device; otherwise the
default input device is the last selected WME driver (soundcard). The WME input and ASIO I/O device can
be selected in Main->Settings->Input Tab; here you have also indication of the ExtlO dll loaded at start-up
(if any).

If no WME specific device is selected, the system default (sound mapper) will be used. If you wish to use
ASIO devices you must select an ASIO driver. Input source selection is done on the Options menu: OPT-
>Select Input. Let's take as an example that you have a Perseus connected and the ExtlO_perseus.dll
loaded. If the hardware is powered and ready, you should hawe it selected as the input source.
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3.4 Selectingan outputdeviceforaVRX

e ] B~ — i
Jsawne | nos | cat | oriokiDN ; quanAnn =]
e : pu g (e B

Line 1 (virtusl Audio | wooe NI [saw ] (7 ][ow ]
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Line 1 (Virtial Alidio Cable) > | I v ] o] JSo. .20
Speskers (- UsB Audo [ ] [sweu] [ ] Lo | [om] T T T
[cware] X (ves] O o
-130 a8 AGc [vena] 15 “12 10
 — R | | _
O — > | £ 2., Clear Enter

[ Lock Output Fractional Resampler

As already seen previously, each VRX can hawe its WME output device. More VRX can share the same
WME device. Output device can be selected in RX Control->Settings->Out Tab. If no device is selected
(default) the VRX will use the system default (sound mapper).

3.5 SelectinginputSR(WME and ASIO inputonly)

Main Settings Bl sev. wa SDRuno  MaIN
CAL | OFFSET | TMATE | ORIG

Final SR: 2000000

WME Input Device A SP2 y IFBW: 1.536MHz (ZIF)
ﬂ GR: 71dB

Line 1 (Virtual Audio Cable) [ DD vRX]
Line In (2- Scarlett 2i2 USB) -
Microphone (3- USB Audio Panel oy oee |

Input Level Display  |Gain Reduction |id 2
[z A
i o o | —
) e M S B

IF AGC [
2 4/5/2017 11:09:01 PM RSP2 Pro

Input SR selection is done in Main->SR button: the SR menu will popup.

3.6 Startingthe DSP engine

sem. 5] =5
Final SR: 2000000

IFBW: 1.536MHz (ZIF)

0 [=on | [Fsez| o o s

(RO AR

SR (MHz) DEC
A=z ) |
EER] e vorcr et

Sys: 0%

4/5/2017 11:11:56 PM RSP2 Pro

Now you are ready to test your setup: click on the big button “PLAY” in the main window. You should hear
noise or demodulated audio and the spectrum windows should also work.
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3.7 Settingthe RX frequency

BwW SDALNG RX CONTROL RSYN1 MCR
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You have multiple choices for inputting a frequency value:

SDRuno User Manual

Clear Enter

- Clicking on one of the band buttons (under the S-meter in the RX Control window).
- Moving the cursor to a specific digit in the frequency display (inside the RX Control window or

inside SP1if the dial is enabled) and turning the mouse wheel.

- Using the current tuning step turning the mouse wheel (when the cursor is outside any control and
one of the VRX windows is selected).

- Entering the frequency directly with the mouse and/or the keyboard.

- Clicking on the Main Spectrum window (spectrum or waterfall); the actual selected frequency is
the nearest multiple of the current tuning step.

- Using the Memory Banks features.

- Using a dedicated hardware controller (Tmate — Tmate 2).

- Using CAT control and/or Omnirig.

R1.13
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3.8 Changingthetuning step

Tuning Step

ot e e
14020 : 1 Hz 3 14060

10 Hz
50 Hz
100 Hz
250 Hz
500 Hz
1 kHz

5 kHz
6.25 kHz
8.33 kHz
9 kHz

10 kHz
12.5 kHz
15 kHz
20 kHz
25 kHz
50 kHz
100 kHz
200 kHz

SETT. RDSW EXW SODRLNO RX CONTROL RSYN1

STEP: UL lore dm m
B [ "|,|_| (RN N —

mope MEEE----

VFO - QM FM MODE cw oP NOTCH T T p—
M-E@-W-@ 80 2
[vros] (e | N [ 22° ][22« ][ 20k ][ wen ] [wen2 | ‘ 20 "
[ous | [our ] [cwasc] (e ] EIIE [wons | .T_,_q_
-130 dB AGC ii_ £ ﬂ.
T | I T R | TN
(voe | JEEN(sov] wlue Clear Enter

Right-click on the RX Control frequency dial: the dial step menu will popup. Select the desired tuning step.
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3.9 Entering frequencydirectly

RSYN1 MCTR T

INTROL e B0 = B Oi=T X
500 Hz
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VFO - QM FM MODE Cw oP FILTER NB NOTCH
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| — | e |
Ea] — - |20 2. Clear Enter

If you wish to use the keyboard one of the VRX windows must be selected. In order to enter a frequency
directly with the keyboard and/or mouse:

- Press the SPACE bar or click on the RX Control frequency dial; this will start the input sequence.
The dial will display 0 and the white frame around the dial will turn to yellow. In order to abort the
input sequence press the ESC key or click on the Clear button in the RX Control window.

- Enter the frequency in KHz using the numeric keys and/or clicking on the band buttons. If you
wish to enter Hertz values use the decimal separator of your system. For example if you wish to
enter 1455202 Hz type in 1455.202 (or 1455,202 depending on the system). Note: you can use
whatever decimal separator you wish; the program will replace it automatically (if needed) with the
correct one.

- Press Enter or click the Enter button in the RX Control window. If the value has been accepted the
dial will show the new frequency.

3.10 Minimize/Restore All option

SETT. | MA SDRuUNoO  MAIN

Final SR: 2000000

IFBW: 1.536MHz (ZIF)

o= =] [ w] | GRe €248

SR (MHz) DEC
i
ITER] e vorcr A

Sys: 9%

4/7/2017 9:16:18 AM SDRplay RSP

As the SDRuno GUI is made of many independent windows, an option to minimize or restore all the
windows of an instance with a single action can be very handy sometime. The “minimize-restore all”
option is controlled by the small “MA” button located in the upper left of the Main window. When enabled,
minimizing or restoring the RX Control or the RX EX Control window will result in minimizing or restoring
all the opened windows in the relative SDRuno instance.
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3.11 VRX background

RDS | caT | oriG | [IE=l cAL [«]»]
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VRX BACKGROUND COLOUR
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[ [o] i
:212"

2 Clear Enter

The VRX background colour can be customized by the user; the relevant control is located here: RX
Control window->SETT.->MISC->VRX BACKGROUND COLOUR. Currently this parameter only affects
the spectra (MAIN SP and AUX SP) background. In the future the functionality will be extended to all the
VRX windows.

3.12 Using multiple VRX while playing IQ files

SETT. | |Ma SDRuno  MAIN ng
INPUT CAL | OFFSET | TMATE | ORIG Rii¢le}
Final SR: 2000000 > pusc.)
IFBW: 1.536MHz (ZIF) E IARU REGION 1 S-METER STANDARD
0 (e ) oRisods || m

[ REVERSE MOUSE WHEEL
[ sHow uTC TIME
[ MULTI VRX WAVE FILE MODE

SR (MHz)  DEC
WAV FILE MAX RECORD LEN MB
| — L

4/7/2017 9:58:51 AM SDRplay RSP

SDRuno allows the use of multiple VRX while playing IQ files. Main window->SETT.->MISC->MULTI VRX
WAVE FILE MODE. This option is enabled by default; if you wish to use only VRX#0 uncheck the option.
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3.13 RDS
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_2_ Clear Enter

There is a “DX mode” feature in the RDS decoder. The RDS processing offers “state of the art”

performances, very close to the theoretical limits. Testing has shown
RDS PI from a signal with only a 10 dB S/N ratio.

R1.13 Copyright © 2017 SDRplay Limited

that it is still possible to obtain a valid

21



K
55@/55/' SDRuno User Manual

3.14 RDS “DX-mode”

RDSInfo 0-0

PI: 26923 (692B)

PS: Music [.:..]

PTY: Top 40

RT: 2[100 NY's Tl Hit Music Station

|

RDS data is transmitted in pieces called “RDS groups” and each group is composed of four “RDS blocks”.
To obtain valid data the RDS decoder must achieve “synchronization” first; this means that a correct
sequence of blocks “A” to “D” must be validated by the embedded error correction system. In very poor
S/N ratio (approximately below 11-12 dB) this is impossible. In normal use this is usually not a great
concern but for DX enthusiast it is, as the main goal is the identification of the broadcaster by the RDS PI
data. Pl data is embedded at least in all “Block A” of any RDS groups so it is one of the more redundant
pieces of information transmitted. In RDS “DX-mode” SDRuno tries to extract the Pl by attempting a
partial synchronization, then the relative Pl data is shown in red. The level of confidence is very high (>
99.5%). The RDS decoder exits “DX-mode” once full synchronization is achieved and the PI label returns
to its normal state. In order to re-enter DX-mode you have to reset the decoder by the RESET button in
the RDS Info window. For marginal signals DX-mode can be a very useful tool.

3.15 IQ Wav files maximum length
Wi Settings B o Ol= Ix] s ma

INPUT | CAL | OFFSET | TMATE | ORIG | fli&{s}

a IARU REGION 1 S-METER STANDARD IFBW: 1.536MHz (ZIF) IFBW: 1.536MHz (ZIF)

e —— 0 || 0 [Eesi| _ e

[ sHow uTC TIME ’ 5

[ MULTI VRX WAVE FILE MODE =4
SR (MHz)  DEC SR (MHz) DEC

WAV FILE MAX RECORD LEN MB ] acc | ‘
Gai

(MIN = 64 MAX = 4096)

n RF Gsin
Reduction [z | EIIEEEEN resuction
Sys: 3% Sys: 2%

4/11/2017 9:48:16 AM SDRplay RSP-1 4/11/2017 9:48:17 AM SDRplay RSP-2

The user has an option to define a custom file length up to 4 gigabytes (10243 bytes) which is the limit of
the wav format itself. In fact, in the Wav file header size is stored as a 32 bit unsigned integer so the
storable maximum size is 232 bytes. In the future SDRuno will offer the option to store IQ data in another
format, without the abowe limitations. Please note that the advantage of keeping the wav format is
compatibility: SDRuno files can be opened with any tools that support that file format. To change the
default file size (2048 megabytes) go to Main->SETT.->MISC, double click on the “WAV FILE MAX
RECORD LEN” and enter the new size, then press Enter to confirm.
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4. “Hidden” functionsin SDRuno

4.1 Selectingtherecording folder

Select SDRuno Record Folder

My Documents —ovr | [Recvane] Final SR: 2000000 [(ovr ) [Recwaner | Final SR: 2000000
¥ My Music IFBW: 1.536MHz (21F) IFBW: 1.536MHz (21F)
B My Pictures o= 1=]1 o= 1=]H oR: da
B My Videos [Avo vex]

Roaming s
B s o sequns)  oEc seoms) o | -

| o] =0
[wz] et
—_——

4/11/2017 9:54:12 AM

¥ Searches

8 Comouter

Make New Folder

Right-click on the Recorder button in the Main window or on the Recorder window: this will pop up the
folder selection window. The factory default is to use your “My Documents” folder.

4.2 Usingthecustom controls

SDRuno implements some custom controls specifically created for it.

4.2.1 Sliders

SDRALUNO RX CONTROL RSYN1

wce rew B0 5 8811
(nnannnnn e =] TR

VFO - QM FM MODE Ccw opP FILTER NB NOTCH ! o <

I (55 (e | [ ] [wew] o ] [Cmoe ] [ow ] (o] 160, .80, 40

30 20 47

(BT ~eor JIETTEN| —_—
AGc 15 12 10
IEEH (50w | 2 Clear Enter

Sliders are used for some parameters such audio lewvel, squelch lewel etc.
You have seweral options to modify a slider value:

- For quick, large changes simply click in the new position of the slider

- For continuous variations click and drag.
- For fine, precise control put the cursor inside the slider and turn the mouse wheel
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These controls are easily recognizable as their background turn to purple as you place the cursor above
them; some examples are the notch filters BW and Freq. controls in the “RX EX Control” window. In order
to change the value of one of these controls, you must place the cursor inside it, then you hawe seweral
options (here is an example for a notch Freg. control — actual steps depend upon the specific function):

- Turning the mouse wheel will change the value in +/- 1 Hz steps

- Turning the mouse wheel while pressing the SHIFT key will change the value in +/- 10 Hz steps
- Turning the mouse wheel while pressing the CTRL key will change the value in +/-0.1 Hz steps
- Right-clicking will change the value in + 100 Hz steps

- Left-clicking will change the value in - 100 Hz steps

- Right-clicking while pressing the SHIFT key will change the value in + 1000 Hz steps

- Left-clicking while pressing the SHIFT key will change the value in - 1000 Hz steps

- Right-clicking while pressing the CTRL key will change nothing (not used in this case)

- Left-clicking while pressing the CTRL key will change nothing (not used in this case)

4.3 The spectrum “quick browser”

Span 192 KHz FFT 679 Pts RBW 141.38 Hz Marks 2000 Hz

-80000 -60000 -40000 20000 40000 60000 80000

Sometimes in a spectrum window you need a high zoom factor and at the same time you need also to
mowve quickly to another part of the spectrum; as the shown spectrum portion is small in comparison to the
total it would take ages to reach the wanted position dragging the frequency scale. SDRuno has the “quick
browser” function:

- Place the cursor inside the frequency scale.

- Press the SHIFT key, a yellow owerlay will appear on a portion of the scale: here the size and
position of this owverlay indicates the currently shown portion of the spectrum relative to the total
(the whole frequency scale).

- Click and drag the above owerlay until the window shows the spectrum portion you wish.
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4.4 SP2filter adjustments

e

Besides the usual dragging of the selectivity filter edges (the red cursors) in the SP2 window there are
other some useful features available.

4.4.1 Asymmetrical adjustment

Usually in AM, SAM (DSB) and FM mode, dragging one edge has the effect of controlling simultaneously
the other in order to create a symmetric filter (around 0). In SDRuno the selectivity filter high and low
frequency parameters can be different. If you wish to set up an asymmetrical filter drag one edge while
pressing the CTRL key.

4.4.2 Pass band Tuning

Put the cursor in between the filter red cursors. Right-click and drag: this will have the effect of moving
both the filter edges (pass band tuning).

4.5 S-Meter function
SETT. RDSW  EXW RSYN1 | Mcmr | Tem | [ - o X

(02100000~ m——
L,

wooe [ am | [ saw | TN cw [[ose |[ss |[ uss | [orerad]

VFO - QM FM MODE CwW oP FILTER NB NOTCH

XN (+>= ] (o] e ] [owewc] [Coow ] [Csoe ] [wew ] [wer ] 19, B0, A0

(vros] (s> ] (e | I (2w | (oo | IR [oow | [womz] T ™o T
-130 dB AGC 15 12 10
ETE] = — > |EXT 2, Clear Enter

In order to change the S-Meter function to FM tuning meter and vice versa, simply click on
it.
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4.6 Temporary LOLock
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4/11/2017 9:56:13 AM SDRplay RSP-1 SDRplay RSP-2

Changing the hardware LO has the effect of changing the tuning frequency of all the active VRX This
happens when you change the tuning frequency of VRX #0 (the master RX). If you wish to change the
frequency of VRX #0 without changing the hardware LO you can use the LO LOCK button in the Main
window. But if you need only a temporary lock simply press the SHIFT key while tuning.

4.7 Quickrecording

SDRuno includes a feature to put a SDRuno instance in recording mode “on the fly”, without opening the
Recorder window. When you wish to start recording simply press “*’ on the keyboard (the relative SDRuno
instance must be selected).

4.8 CW pitch (CW shift)

SETT. FMAF

In CW receiving mode a VRX uses a frequency offset in order to obtain a CW note. This offset can be set
as follows:

- Make sure you have the DSP engine running (so to have the spectrum windows updated).

- Select CW receiving mode.

- Place the cursor in the spectrum part of the Aux Spectrum window (SP2); a green vertical line will
be shown at cursor position.

- Choose your new CW pitch moving the abowe line to the corresponding mark on the frequency
scale; a positive value will set a “lower than carrier” offset (USB-CW) while a negative value will
set a “higher than carrier” offset (LSB-CW).

- Assign the new offset by Left-Click while pressing the CTRL key.
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4.9 Quicknotch frequency setting and the notch-lock function
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Each VRX offers four notch filters to suppress unwanted signals, placed before the AGC. Each notch filter
can be enabled/disabled by the relative button in the RX Control window. The notch filters BW &
Frequency settings are available in the RX EX Control window. For notch filters 1 & 2 the frequencies can
be quickly set “on the fly” as follows:

- Place the cursor in the spectrum part of the Aux Spectrum window (SP2); press and hold the
SHIFT key: a yellow vertical line will be shown at cursor position.

- Mowve the abowe line next to the signal you wish to suppress.

- Assign that frequency to Notch 1 by Left-Click or Notch 2 by Right-Click.

- Release the SHIFT key.

- For each enabled notch the relative frequency is marked in the spectrum by a dotted \ertical line,
light-blue for Notch 1 and light-pink for Notch 2.

The NCHL button in the RX Control window enable/disable the notch-lock feature. When notch-lock is
active, the notch filters frequencies are updated when the receiving frequency is changed.

Let’s see the purpose of the Notch Lock function in a typical usage scenario: you are following a SSB
QSO where some operators are each other slightly off frequency, requiring retuning for good audio. At the
same time you are using a notch filter to kill a heterodyne tone caused by a nearby emission. Without
notch-lock you should re-adjust the notch filter(s) frequency every time you retune; notch-lock does this for
you automatically.

4.10Adjustingthe proportion of spectrum and waterfall displays

X

14043237
LG 14740847

Inside SP1 and SP2 windows, for the SP+WF display mode you can alter the proportion of the SP vs. WF
by right-clicking the frequency scale and dragging it vertically to the desired position.
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4.11Keyboardshortcuts

A
1 |.<
mne T aabO™0ng

P 1

H—osz=2zmc
o533

1
-~

SPACE
Enter

CTRL+F
CTRL+S

Ins

Del

F2
CTRL+S

b 3

H-h
B-b
Up/Down
Arrows

Function:

Select AM rx mode

Select SAM rx mode

Select FM rx mode

Select CW rx mode

Select DSB rx mode

Select LSB rx mode

Select USB rx mode

Select User rx mode

Select NFM rx FM sub-mode
Select MFM rx FM sub-mode
Select WFM rx FM sub-mode
Select SWFM rx FM sub-mode
Toggle Rx/Tx mode(a)

Starts direct frequency input seq.
Closes direct frequency input seq.
Aborts direct frequency input seq.

Show/hide the files pane

Store enabled VRX to memory location (same as STORE
button)
Inserts a new row after the current

Deletes the current row
Starts editing the current cell
Store specific VRX to memory location

Starts IQ file recording

Shows the ExtIO panel (if loaded)
Shows the Memory Panel window
Change frequency by step size

Note 1: Controls not available when the memory panel is selected.
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Scope:
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX
VRX

Memory
Memory

Memory
Memory
Memory
VRX

Panel
Panel

Panel
Panel
Panel

Instance()
Instance()

Instance

VRX
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4.12The /O Sample Rate differenceissue
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Using different physical input and output devices means that there is no synchronization between the I/O
sample rates; further more, a small deviation (in the order of less of ten to some hundreds of PPM) from
the theoretical rates exists. SDR programs (including SDRuno) use memory buffers as “dampers” that
absorb those differences; howewver, sooner or later the buffers will be all filled (owerflow) or all empty
(underflow), depending upon the sign of the combined input and output devations. With typical hardware
this can happen after seweral hours of continuous processing. At that point the program will re-establish
the correct buffering, trashing some data and creating a small “gap” in the output stream. Of course there
is a way to prevent this, implementing a complex closed loop seno system that monitors the buffering and
controls an output fractional resampler. SDRuno can do this and it works very well, ensuring that no data
are lost at any time. However, when the abowve system is enabled a small frequency modulation of the
output signal occurs (in the order of a fraction of Hz when the seno has settled down). In some sensitive
applications (APT & other critical signal post-decoding), this small modulation can sometime cause
problems; in SDRuno there is an option to disable the output resampler: RX Control ->SETT.->OUT->Lock
Output Fractional Resampler. By default the output fractional resampler is enabled.

5. S nchronous AM
0-00= X s | wow| ow v | wem | vem | -0
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SDRuno implements a high performance SAM mode. When you select SAM the last used sub-mode is
also recalled (LSB, USB or DSB). Once SAM is engaged you can switch to the desired sub-mode by
clicking the relative buttons:

- LSB: lower sideband SAM
- USB: higher sideband SAM
- DSB: double sideband SAM

LSB and USB SAM sub-modes share the same selectivity filter settings while DSB has its own settings.
Some common filter settings are available as presets in the RX Control window. Of course you can set the
filter manually as indicated in 4.4. Automatic volume compensation is performed while switching from LSB
or USB to DSB. To leave SAM mode you can either click on the SAM button again (this will select the last
used SSB mode) or select any other reception mode.
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5.1 SAM:whatis new?
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In SDRuno the SAM PLL has its own AGC and selectivity filter. There are many advantages in using this
configuration:

- The demodulation AGC timing can be optimized for listening while a much faster PLL AGC can
cope with fast, deep fading

- The PLL selectivity filter can be made very narrow in order to allow only the wanted carrier
passing thru; this way little noise reaches the PLL and the lock on noisy signal is much improved

The PLL step response can be set to two different modes:

- FAST: this is the default mode; in "fast” mode the PLL can track phase-modulated carriers that
contain embedded data streams (for example BBC on 198 KHz), awiding the demodulation of
those noisy unwanted signals. Lock time is fast ewven if you are off-tune but the PLL is also more
sensitive to noise given the wider loop bandwidth.

- SLOW: this is definitely the DX choice; lock time is slower and the PLL is much more immune to
noise. This mode combined with a narrow PLL BW filter setting gives exceptional lock stability on
very noisy signals.

Locking range is limited with this setting: if this is a problem, first select FAST mode then switch to SLOW
if required.

The pre-PLL pass-band filter can be adjusted from +/- 50 Hz to the full bandwidth available. Please note
that this setting also limits the range in which the PLL can achieve lock: for example if you are using a 500
Hz setting (default) and you tune outside the +/- 500 Hz from the carrier, the PLL will never lock as the
carrier is filtered out.

All the PLL AGC parameters are pre-fixed for best results minus the release time. This parameter can be
optimized for the specific reception condition; usually the default value works well.

All the SAM settings are available in RX Control->Settings->SAM/HP Tab.
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In SDRuno the hardware frequency calibration can be done manually in Main Window->Settings->Cal or
automatically in the VRX Control Window->Settings->Cal. For manual calibration, you can input a value in
Parts Per Million; that value will be positive if the hardware oscillator is lower than its nominal frequency or
negative otherwise. You can do the calculation of the compensation value at any frequency but best
accuracy is achieved using the upper tuning range of the hardware. You need a reference signal whose
frequency is known and accurate (for example in HF could be WWYV on 15000 KHz).

Let's see an example using CHU (14670 KHz) as reference:

- Using the Aux Spectrum window with a high zoom factor tune carefully the reference signal until
you have the carrier at 0 Hz in the spectrum.

- Read the frequency indicated on the dial. In this example it is 14670082: this means that the
reference oscillator in your hardware is lower than its nominal value.

- Compute the error as 14670082 — 14670000 =82 Hz.

- Compute the PPM compensation value as 82 * 1000000 /14670000 = 5.590

- Insert the above value in the HW LO Freq. Calib. edit box and press the Enter key.

- Retune the reference frequency and check that the calibration is effective.

For automatic calibration, follow the instructions within the VRX control window->Settings->Cal panel.

7. S-Meter calibration
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SDRuno automatically calibrates both the power measurement and the S-Meter for the RSP device.
Additional external gain or loss can be set in Main Window->Settings->CAL->EXTERNAL FRONT END
GAIN.
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8. External converter offset
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Up to four converter offsets can be stored in each instance of SDRuno. Offset settings are available in

Main window->Sett.->OFFSET.

8.1 Changingaconverterfrequency offset

Enter the new frequency in the edit box to the left of the relative button then press the ENTER key.

8.2 Enabling aconverter offset
Click on the relative offset button.

8.3 Disable active offset

Click on the NONE button.

8.4 Inverted spectrum mode

Select Input

High Process Priority
E] Normal Process Priority

[®] WMME 16 bit drivers

Mode
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Channel Skew Calibration...
Reset Default Settings

User Manual

About
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SDRplay RSP

Some conwerter is designed so that its LO frequency is greater than the input signal frequency; because
of this the output spectrum is inverted. In such case the inverted spectrum mode must be activated,
clicking the INV button. Also the | and Q channels must be swapped (Main window->OPT->Swap | and Q

Channels).
9. CAT
R1.13
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CAT control has been around for at least 25 years so it is a well-known technology: there is no need to
review the basics here but a little refresh may be useful to understand how CAT has been implemented in
SDRuno.

Whatever CAT protocol we choose, there is always a controlling device and a controlled one. In origin
controlling devices were PCs and controlled devices were physical radios (receivers or transceivers) and
accessories (rotors, switches, amplifiers etc.). Physical communication ports (serial ports for example)
were used for the data exchange.

Per definition, in a CAT session only the controlling device can initiate a transaction. For example, the PC
might send a “give me the VFO A frequency” while the radio might reply “the VFO A frequency is 3561230
Hz”.

The logical roles can’t be exchanged.

Now that we have software radios (like SDRuno) a CAT session can be no more necessarily only between
a program inside a PC and an external device but can be also between different programs inside the
same PC (and even in different PCs).

In order to achieve this we need a way to interconnect programs; one common solution is using special
software tools to create “virtual com ports” pairs interconnected with “virtual null modem” cables. Then
applications can see the virtual com ports as real ones, using them for communication. More on virtual
ports later.

Another requirement we need is that the software radio must “impersonate” a controlled device and react
the same.

9.1 How SDRunoimplements CAT

CAT has been designed in SDRuno so that the application can act as a controlled device and a controlling
one at the same time. More precisely, each VRX can be seen as a separate radio on a different com port
while at the same time it can control a physical external device via Omnirig.

For CAT radio emulation we chose a sub-set of the extensive Kenwood command set.
The following VRX parameters can be set and read:

- VFO A Frequency

- VFO B Frequency
- Active VFO (A - B)
- RX Mode

- AF lewel

- Squelch level

- S-meter (read only)

Also several commands are implemented in a dummy way just to make some controlling programs happy
(HRD for example).
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9.2 VRX CAT parameters
VRX CAT parameters are accessible here: RX Control->SETT.->CAT.
9.2.1 COM DEVICE

This combo box allows you to select / enter the serial communication device. It is possibly to choose
among COM1 -> COM20 using the drop-down list. If the desired device has a name that it is not listed,
enter it directly as follows:

- select the text inside the control (double click on the text)

- enter the device name by the keyboard

- press the Enter key on the keyboard

Default: COM10
9.2.2 BAUD RATE

This combo box allows you to select the speed for the serial device. This setting must match that of the
controlling program, the higher the better. It is relevant only if the emulated virtual port has the “emulated
baud rate” option enabled, otherwise it can be ignored.

9.2.3 RX MODE CTRL

This option let you to choose if the controlling program can set the VRX RX mode.

Default: enabled
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9.2.4 ENABLE & CONNECT

This option enables CAT and starts the connection to the selected com device. Once enabled, the
connection is effective until disabled or until the deletion of the relative VRX also the connection is
performed automatically every time the VRX is created. The status of the connection is indicated by the
label placed on the bottom of the window (STATUS: CONNECTED — NOT CONNECTED). To saw
system resources, do not enable unused connections.

9.3 Example: connecting to Ham Radio Deluxe

Start creating a pair of virtual com ports named COM10 — COM11; do not select the “emulated baud rate
(you need to do this only once).

Launch SDRuno; assuming we wish to control VRX#0, open the CAT settings of that VRX COM10 is
selected per default; check “ENABLE & CONNECT”, the status should change to “CONNECTED”. Close
the RX Settings window.

Launch HRD; click on “Connect”. The first time you need to create a new radio connection: select
“Kenwood” as “Company” and TS-440S (for basic controls) or TS-480 (for additional AF gain, squelch
level and S-meter controls) as radio type. Select COM11 as “COM Port” and click “Connect”.

Once the connection has started you can try to change frequency, mode etc.

In other programs select a generic Kenwood as radio or the above models.

9.4 Applications

- Log applications

- Frequencies databases
- Digital modes decoders
- Satellite tracking

- Special controllers

- Others
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9.5 SDRuno asthe controlling device— Omnirig
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SDRuno can control other devices (Ma CAT) thru the Omnirig COM server, a brilliant utility developed by
Alex Showoplyas, VE3NEA of Afreet Software, Inc. The main purpose (and advantage) of Omnirig is to
provide a common “transparent” interface to applications; the controlling application doesn’t have to deal
with a specific radio but instead sends and receives commands to Omnirig that in turn acts as a “bridge”.
Omnirig can be “instructed” to work with a specific radio by “rig description” files that are relatively simple
to create. There is already a huge list of supported devices and others can be added when needed,
without the need to modify the code of neither Omnirig nor the application using it. In the past, Omnirig
has become a standard and a huge list of applications relies on it: it is freeware, reliable and easy to

install and set-up. For details please see the Omnirig web site http://www.dxatlas.com/omnirig/

Stop bits
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9.6 Omniriginstallation and set-up

You may already know about Omnirig and you may have already installed it on your system: if not please
download Omnirig from http://www.dxatlas.com/omnirig/ . Installation is straight-forward: just launch the
installer and follow the instructions. Omnirig can control up to two devices at once (and so SDRuno, see
below), RIG1 and RIG2; both must be configured in the Omnirig control panel. If your rig is not listed
among the available rig types, do a search on the web for a suitable rig description file, then add it to the
“Rig” folder, located inside the Omnirig installation folder. Some setup tips: for best responsiveness use
the higher baud rate your rig supports and set the polling interval to 100 mS. Please note that Omnirig can
also see non-physical devices thru virtual COM ports (other applications for example).

9.7 How SDRunohandles Omnirig

As you know SDRuno is a multi-instance environment; for better control and efficiency SDRuno filters all
the traffic from/to its VRX(s) to/from Omnirig thru an internal own “server’. The latter is created in the
SDRuno instance #0. Omnirig can control up to two devices at once; at a given time only one VRX, of
whatever SDRuno instance is allowed to connect to an Omnirig device (RIG1 or RIG2); a mutual
exclusion logic prevents owerlaps. In short, up to two VRX can connect to Omnirig at the same time, one
per device.

9.8 Monitoring Omnirig status from SDRunoinstance#0

A monitoring feature is available from SDRuno instance #0; go to Main->SETT->ORIG. Look at the bottom
label first: this is the status of the connection to Omnirig; if Omnirig is correctly installed the label must
show “Connected to OmniRig sener’. If there are problems “Can’t connect to the OmniRig server’ is
shown instead: if this is the case recheck Omnirig installation. For each Omnirig device, additional
information is shown (only RIG1 is described, the same applies for RIG2):

RIG1 Type:

Shows the RIG1 device type currently configured in Omnirig.

RIG1 Status:

Shows the RIG1 status reported by Omnirig; if there is an active working connection, the status is “On
Line”. Other statuses include “Rig is not responding” and “Rig is not configured”.

RIG1 Used By:

Shows which SDRuno VRX is currently connected to RIG1 (instance # and VRX #).
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9.9 Which parametersaresynchronized

The following parameters are sent/received from SDRuno to/from the controlled device:

Omnirig SDRuno Note

VFO A frequency VFO A frequency If the controlling device has only one VFO, VFO A is used
VFO B frequency VFO B frequency

VFO selection VFO selection A- B

Modulation mode Modulation mode Optional

RX-TX status RX-TX status Mute the VRX in TX, see below

Note: if the controlled device is a transceiver or transmitter, putting it in TX mode causes the VRX to enter
a special mode: a yellow label “‘RF MUTE” shows up in the RX Control window, the MUTE button (AF
muting) is activated and a 60 dB attenuation is applied to the signal after the SP1 display (so that real
input levels are still shown) to facilitate AGC recovery. As the device exits TX mode the VRX returns to
normal mode. you can use the key shortcut “T” to toggle the RX-TX modes of a synchronized
transceiver/transmitter (provided that the “SYNC VRX -> RIG” option is enabled, see below); this feature

can be useful also if there isnt a synchronized device as it also toggles the RF MUTE status in the
relevant VRX.

9.10 Omnirig related VRX options

Seweral options control the VRX/Omnirig connection; they are VRX parameters and must be set on a VRX
basis. To access these parameters go to RX Control->SETT->ORIG.

9.10.1 RIG SELECTION

These buttons select the target device, RIG1 or RIG2. This setting also changes the name of the RSYN
button on the RX Control window to reflect the selection (RSYN1 or RSYN2).

Default: RIG1.

9.10.2 SYNC VRX->RIG

If checked, the controlled device is synchronized to the VRX (the device reflect changes made on VRX).

Default: checked.
9.10.3 SYNC RIG->VRX

If checked, the VRX is synchronized to the controlled device (the VRX reflect changes made on the
controlled device). You must enable this option to use the muting on TX feature.

Default: unchecked.
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9.10.4  SYNC CENTER FREQ. (LO)

If checked, the frequency information is relative to the VRX “centre frequency” (the SDR hardware local
oscillator). You must enable this option if the controlled device is also the front-end of the receiving chain
that includes SDRuno.

Default: unchecked.
9.10.5 SYNC RX MODE

If checked, the modulation mode is also synchronized.

Default: checked.
9.11 The RSYN button

The RSYN button on the RX Control window activates the synchronization of the relative VRX with the
selected Omnirig device. A mutual exclusion logic awids multiple VRX accessing the same device at the
same time. The status of this button is persistent between sessions.

10. Tmateand Tmate 2

SDRuno natively supports the Tmate controllers from WoodBoxRadio. As the Tmate drivers are “single
client” a way was dewloped to make full use of the controllers in the “multi instance” SDRuno
environment: this has been achieved by implementing a “Tmate server” and using inter-process
communication (IPC).

10.1 Whatdo | need to use Tmate (and Tmate 2) with SDRuno?

First you need to connect the Tmate to a free USB port. For Tmate you need also to install its driver while
for Tmate 2 this is not necessary (Tmate 2 is a HID device so it uses a system standard driver. The
following files (supplied with SDRuno) must be included in your SDRuno folder(s):

- For Tmate: ELAD_Encoder.dIl.
- For Tmate 2: TMATE2_DLL.dIl.

If SDRuno doesn'’t find the needed dll it disables the server and reports the status in the Tmate settings
window.
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10.2 The Tmate server

The Tmate sener implements bi-directional communication between the Tmate and whatever VRX you
like, even across multiple application instances (more on this later). Think of the Tmate server as a “global
resource”; it is created (if needed) by the SDRuno instance #0. The process is of course entirely

transparent to the user.
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10.3 Tmate server options

The Tmate sener options are accessible only from the SDRuno instance #0 from here: Main window-
>SETT.->TMATE.

10.3.1 ENABLE SERVER

This checkbox enable/disable the Tmate server; the sener status is reported on the window bottom: once
enabled, if everything is ok you should read “Tmate server running.”. If the program reports an error, first
check that no other application has allocated the Tmate (remember, Tmate is “single client”).

Default: disabled
10.3.2 AUTO ASSIGN

This checkbox let you choose between two “assigning” options for the Tmate controller.

If AUTO ASSIGN is checked, the VRX controlled by the Tmate is the one that currently has one of its
SP1, SP2, RX Control or RX EX Control windows selected (the “SDRuno” label in the window plate is
red). This is the simplest and fastest way to assign the Tmate controls to a VRX

If AUTO ASSIGN is unchecked, you have to assign the Tmate to a specific VRX by the “TCTR” button
located on the upper-right border of the relative RX Control window. To awid confusion, a mutual
exclusion logic is implemented: only one VRX can be assigned at a given time.

Default: enabled

10.3.3 TMATE 2

This checkbox let you choose between the two Tmate models. You can have both a Tmate and a Tmate 2
controllers connected to the system at the same time. In order to change this setting the Tmate server
must be stopped (uncheck ENABLE SERVER).

Default: disabled (controller type is Tmate)
10.3.4 TMATE 2 USES VRX BACKG.

The Tmate 2 controller features an LCD display with a RGB backlit. This checkbox let you choose
between two backlighting modes:

If checked, the LCD backlighting colour follows the assigned VRX background colour.
If unchecked, the LCD backlighting is set to a fixed neutral colour.

Default: enabled
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10.4 Tmate controls
Currently the Tmate controls are implemented as follows:

104.1 TUNING KNOB

Tmate employs a 128 steps/turn optical encoder. Each step corresponds to a given increment/decrement
of the VRX tuning frequency and it is the same used for the mouse wheel (see 2.7 — 2.8). The current
tuning step is shown in the RX Control window to the left of the frequency dial. When the spinning speed
exceeds a certain threshold, a multiplying factor of 5X is applied to the current step; this feature is quite
common in traditional (hardware) receivers and transceivers. The knob can be locked (see below).

10.4.2 F1 — DECREASE STEP
This button decreases the tuning step to the next lower value (if available).
10.4.3 F2 — INCREASE STEP

This button increases the tuning step to the next higher value (if available).

10.4.4 F3 — KNOB LOCK

This button locks/unlocks the tuning knob; the locking status is indicated in the RX Control window, to the
left of the frequency dial.

10.4.5 F4 — MUTE

This button has the same effect of the MUTE button inside the RX Control window. Please note that the
tuning step, lock and mute options are independent for each VRX

105 Tmate 2 controls

Currently the Tmate controls are implemented as follows:

Rotary encoders:
10.5.1 MAIN ENCODER (TUNING KNOB)

Tmate employs a 32 steps/turn encoder. Each step corresponds to a given increment/decrement of the
VRX tuning frequency and it is the same used for the mouse wheel. The current tuning step is shown in
the RX Control window to the left of the frequency dial and also in the Tmate 2 display. When the spinning
speed exceeds a certain threshold, a multiplying factor of 5X is applied to the current step; this feature is
quite common in traditional (hardware) receivers and transceivers. A further increment in speed triggers a
10X multiplying factor. The knob can be locked (see below). Pushing the tuning knob selects the current
VFO (A - B).
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10.5.2 E1 ENCODER

The function of this control can be selected by the user: pushing the knob selects the current function
among the five available:

- VOL  adjust the VRX audio level (AF level or wolume).
- RFG adjust the AGC gain (if AGC is enabled) or the RF gain (if AGC is disabled).
- SQL  adjust the squelch threshold.

- NR adjust the amount of Noise Reduction
- NB adjust the threshold of the Noise Blanker

10.5.3 E2 ENCODER

The function of this control can be selected by the user: pushing the knob selects the current function
among the two available:

- HIGH adjust the selectivity filter high frequency limit.
- LOW adjust the selectivity filter low frequency limit.

Pushbuttons:

10.5.4 F1 — DECREASE STEP

This button decreases the tuning step to the next lower value (if available).
10.5.5 F2 — INCREASE STEP

This button increases the tuning step to the next higher value (if available).

10.5.6 F3 — KNOB LOCK

This button locks/unlocks the tuning knob; the locking status is indicated in the RX Control window, to the
left of the frequency dial and by the LOCK LED on the Tmate 2 panel.

10.5.7 F4 — ASSIGNABLE BUTTON

The function of this button depends upon the current parameter controlled by the E1 encoder:
- VOL  MUTE on/off.

- RFG  AGC on/off.

- SQL  squelch on/off.

- NR Noise Reduction on/off.
- NB Noise Blanker on/off (NBW only).

10.5.8 F5 — RX MODE
This button selects the current receiving mode.

10.5.9 F6 — VRX SELECTION

This button assigns the Tmate to the next VRX of the same instance.
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LEDs:

USB LED

This LED is lit when there is connection with the Tmate senver.
LOCK LED

This LED is lit when the tuning knob is locked (see F3 button).
LCD DISPLAY

The Tmate 2 display shows many VRX parameters; the tuning frequency field also doubles as parameter
value indicator. When the frequency exceeds the 9 digits capability of the display, the entire field is shifted
one digit to the right (10 Hz resolution).

11. Memory banks

|EIBI Uno.s1b Frequency Description Filter
FM Broadcast.sib »

| 7175000 40m Ham Band

|Ham Bands.s1b

|HF Broadcast.s1b 3800000 80m Ham Band

IVHF & UHF.s1b 14240000 20m Ham Band

18110000 17m Ham Band

21275000 15m Ham Band

24930000 12m Ham Band

28300000 10m Ham Band

New bank
Open bank

Save bank

Save bank as...
Import

Eind...

Select banks folder
Hide files pane
Filter by VRX freq.

SDRuno supports its own memory banks. Considerable efforts have been put into the development of
such an important feature, in order to provide a powerful yet easy to use and efficient implementation.

11.1 Basicconcepts

store {SDRuno mew. pane. § ] = b

[EIBI Uno.s1b Frequency S Mode Description SubM Filter Por 4
|FM Broadcast.s1b

Ham Bal

|HF Broadcast.s1b

\VHF & UHF.s1b

In SDRuno each memory bank consists of a number of “memory locations”. Each memory location is
composed of a number of data fields about a “reception channel” like frequency, description, RX mode
and so on. Physically a bank is saved as a disk file and loaded in memory when needed.
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11.2 The memorybank file format

(™ Ham Band =)
| File Edit Format View Help -

[7175000,Y,L58B,40m Ham Band,,,2800,AntA
3800000,Y,LSB,80m Ham Band,,,2800,AntA
28

SDRuno uses its own extension (.s1b) for memory bank files but the file format itself is not proprietary: it is
a common CSV text file, a format that can be easily handled by many software tools.

11.3 GUIl items added for memory banks management
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In order to implement memory banks, some GUI items have been added:

- A new window, the “Memory Panel” that is the control center of all memory related operations.
- A new button on the “Main” window labelled “MEM PAN”.

- A new button on the “RX Control” window labelled “MCTR".

- Some new keyboard shortcuts.

These controls are described in the following chapters.
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11.4 The “Memory Panel” window

store

[EIBI Uno.s1b Frequency S  Mode Description SubM Filter Port
|FM Broadcast.s1b )
|Ham Bands.s1b

iHF Broadcast.s1b

[VHF & UHF.s1b

The Memory Panel window is an instance resource: you can have one for each instance of SDRuno (you
actually need two of them in order to perform some advanced operations, more on this later); the window
is resizable and its vsibility parameters are stored in the workspace. To show the Memory Panel window
click on the MEM PAN button on the Main window or press the B key from any window of the program.

The Memory Panel is functionally split in two parts: the left part, also called the files pane and the right
part also called the data grid. The files pane shows all the bank files in the current banks folder; you can
quickly open one of the listed banks by double-clicking its name. On the bottom of the list a label shows
the name of the currently loaded bank. The files pane can be hidden/shown with the CTRL+F keyboard
shortcut or from the window context menu (mouse right-click); this setting is persistent (saved in the

registry).

The data grid is the key control: here the current bank data are showed in cells organized in rows (the
memory locations) and columns (the data fields), much like some spreadsheet programs you have
probably used.

11.5 Memory datafields

sTore gl=]=

.
|EIBI Uno.s1b | Frequency S  Mode Description SubM Filter Port
FM Broadcast.s1b B

|Ham Bands.s1b
lHF Broadcast.s1b
[VHF & UHF.s1b

Currently each memory location includes 5 data fields:
Frequency

This is the most important field of course; frequency is expressed in Hertz up to 10 digits. If left blank the
program will not change the tuning frequency of the relative VRX upon recalling.

S (scan mode)
This single character field is a flag for the SDRuno scanning feature (not yet implemented); its purpose is

to instruct the scanning system on what to do with that specific memory location. Allowed values are
blank, Y and N.
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Mode

This field indicates the RX mode for that memory location. Allowed values are: blank, AM, SAM, FM, CW,
DSB, LSB, USB, and USER. If left blank the program will not change the RX mode of the relative VRX
upon recalling.

Description

This field include an optional alphanumeric description of the memory location. The maximum length is
undefined; however the grid editor for this field limits the input to a maximum of 255 characters.

uTtcC
This field can optionally include a description of when the relative channel is on-air, a feature usually

included in many frequency databases. The format is XXXX-YYYY where XXXX is the start time and
YYYY the stoptime (UTC time); for example 0000-2400 means that the station is on air 24 hours a day.
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11.6 The datagrid
0

[EIBI Uno.s1b

FM Broadcast.s1b
Ham Bands.s1b

‘,HF Broadcast.s1b

[VHF & UHF.s1b

The data grid has the main purpose of showing data but it also provides many ways for editing. Inside the
grid you can:

- Scroll the bank data with the mouse wheel, scrolling bars or up-down arrow keys.
- Customize the columns order.

- Insert (add), delete, move and copy/paste rows.

- Manually edit single cells.

- Copy-paste single cells and cell selections.

- Perform row sorting (ascending/descending) with a single click.

- Search for specific data (incremental search).

- Filter data

Selected data fields are shown in yellow.
The current active cell is highlighted with a brighter background.
The current active row is shown by a small arrow marker shown in the row header.

11.7 Basic operationsinthe datagrid

11.7.1 Customizing the columns order

By default the grid shows the columns in the same order as the relative data fields are stored in the bank
file. However you might want to change the columns display order. To move a column to a new position
click and drag the relative column header to the new position (a green arrow shows you the insertion
point), then release the mouse button. Columns order is persistent (it is saved in the registry).

You can't change the columns width.

11.7.2 Manual editing of cells

lEIBI Uno.sib m S  Mode Description SubM Filter Port
|FM Broadcast.s1b | |
|Ham Bands.s1b

[HF Broadcast.s1b

\VHF & UHF.s1b

In order to start manual editing of a cell you have two options:
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- Click on the relative cell then press F2.
- Double-click the cell.

The abowve

operation starts the specific editor for that cell:

- The Frequency field editor allows up to 10 numeric characters.

- The Description field editor allows up to 255 alphanumeric characters.

- The Mode and S field editors are of the combo-list kind: upon pressing the combo button you are
allowed to select one of the values in the drop down list.

- The UTC field editor allows up to 9 alphanumeric characters.

To close the editor press the Enter key (combo-list editors close automatically upon selection). If the entry
is invalid the cell shows the previous data.

11.7.3

Manually inserting a new row

= =%

New rows
key.

11.7.4

[EIBI Uno.s1b Frequen S  Mode Description SubM Filter Port
|FM Broadcast.s1b !

:Ham Bands.s1b
|HF Broadcast.s1b i

[VHF & UHF.s1b ‘
\

are always inserted after the current one. To manually insert a new (blank) row press the Ins

Deleting a row

|EIBI Uno.s1ib Freguen S  Mode Description SubM Filter Port
|FM Broadcast.s1b

|Ham Bands.s1b

HF Broadcast.s1b

|VHF & UHF.s1b

To delete the current row press the Del key.

R1.13

Copyright © 2017 SDRplay Limited 49



K
5ﬂﬁ'p/ag)— SDRuno User Manual

11.7.5 Moving a row

=

[EIBI Uno.s1b Frequency S  Mode Description SubM Filter Port
|FM Broadcast.s1b ) |
iHam Bands.s1b I Frequency

|HF Broadcast.s1b

|VHF & UHF.s1b

To mowe a row to a new location click and drag its header to the new location (a green arrow shows you
the insertion point); finally release the mouse button.

11.7.6 Copying a row

If you don’t want to overwrite a previous row, first insert a new blank row to be used as the destination
one.

- Select the source row by clicking its header.

- Copy to clipboard by CTRL+C shortcut.

- Now click the row header of the destination row.
- Paste from clipboard by CTRL+V shortcut.

11.7.7 Copying a single cell
stone

[EIBI Uno.s1b Frequency Description Filter
R 7175000 40m Ham Band
|Ham Bands.s1b d
|HF Broadcast.s1b 3800000 80m Ham Ban
IWVHF & UHF.s1b 14240000 20m Ham Band
18110000 17m Ham Band
21275000 15m Ham Band
24930000 12m Ham Band
28300000 10m Ham Band
28300000

[Fam Bandss1b |

- Click on the source cell; copy to clipboard by CTRL+C.
- Click on the destination cell; paste from clipboard by CTRL+V.
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11.8 Bank file operations

11.8.1 Changing the current Banks Folder

Frequency s Mode Description SubM Filter Port

New bank

Open bank

Save bank

Save bank as...
Import

Find...

Select banks folder
Hide files pane
Filter by VRX freq.

The default Banks Folder is My Documents\Mem_banks.

To change the Banks Folder, pop up the context menu (right-click on the files pane or the grid) then
choose Select banks folder; navigate to the new folder then click OK. The Banks Folder is persistent (it
is saved in the registry).

11.8.2 Opening a bank file

Frequency S Mode Description SubM Filter Port
4 \

New bank

Open bank

Save bank

Save bank as...
Import

Find...

Select banks folder

Hide files pane

Filter by VRX freq.
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The quick way to open a bank file is by double-clicking its name in the files pane. Another option is by
the context menu Open bank option.

Caution: in order to speed up operations, SDRuno will not bother you with pop-up windows asking if you
have saved your data. So if you made modifications to the current bank, make sure to save it before
loading a new one.

The last used bank is automatically reloaded at the next program start-up.

11.8.3 Saving a bank

SDALUNO MEM. PANEL Hi=IX

Frequency s Mode Description SubM Filter Port
2 |

New bank

Open bank

Save bank

Save bank as...
Import

Find...

Select banks folder
Hide files pane
Filter by VRX freq.

To sawve an already named bank choose Save bank from the context menu. If the bank is new (unnamed),
Save bank starts a Save bank as... operation instead (see below).

11.84 Saving a bank with a specific name

This is the usual Sawe as operation: choose Save bank as... from the context menu. A save dialog
window let you naming the file; if the file already exists a warning window pops-up.
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11.8.5 Creating a new blank bank
E] 5

Frequency s Mode Description SubM Filter Port

»

New bank

Open bank

Save bank

Save bank as...
Import

Eind...

Select banks folder
Hide files pane
Filter by VRX freq.

To create a new, blank bank choose New bank from the context menu.

Caution: as for the Open bank option in order to speed up operations, SDRuno will not bother you with
pop-up windows asking if you have saved your data. So if you made modifications to the current bank
make sure to save it before creating a new one.

11.9 Recallingamemory location
= X | sem | wew | ow

Frequency S Mode Description SubM___Filter __Port

In this context recalling a memory location means assigning its Frequency and Mode parameters to a
SDRuno VRX As an instance of SDRuno can hawe more than one VRX you need a way to tell the
Memory Panel which is your “target” VRX this is the purpose of the MCTR button on the RX Control
window. The MCTR button “connects” a specific VRX to the Memory Panel for some operations. A mutual
exclusion logic is implemented: only one VRX can be assigned at a given time (inside the same
application instance). Once a VRX is “connected” recalling a memory location is straightforward: simply
click on any cell of the wanted memory location (row).
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11.10 Storing to amemory location

O — ] 50w | B, Clear Enter

Storing to a memory location imply first inserting a new blank row after the current one, filling some fields
automatically and finally making that row the current one in preparation for the next operation. The
program fills the Frequency and Mode fields with data from a specific VRX You have different options to
perform the abowve operation:

Storing from a VRX with the MCTR button active

- Click on the STORE button on the Memory Panel.
- Alternative way: use its keyboard shortcut CTRL+S (the Memory Panel window must be selected).

Storing from a VRX that has been selected regardless of the MCTR button status

- Use CTRL+S (one of the VRX windows must be selected).

11.11 Importing from other databaseformats

Frequency s Mode Description SubM Filter Port

New bank
Open bank
Save bank
Save bank as...
| ( Import " EBi CSVFile
Find... Perseus Userlist

Select banks folder

Hide files pane
Filter by VRX freq.

In a future SDRuno will be capable of importing data from all the most used frequency databases.
Currently the Import feature only works for EiBi database files (CSV format) and Perseus “Userlist”
(*.txt) files. In order to import from a database chose Import from the context menu, then select one of the
import options. Locate the source file and click Open. The import process takes a couple of seconds
(depending on the length of the database and your PC processing power).

The bank thus created can be saved as a SDRuno regular bank file.
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11.12 Advanced editing operations

11.12.1  Sorting the memory bank

0= |x
6" requency S  Mode Description UTC SubM Filter Port )

You can sort the loaded memory bank using any of the data fields as the main sorting key. To perform
ascending sorting, click on the column header of the field you wish to use as the key. Click again to
perform descending sorting. A further click undoes the sorting. An arrow indicator shows up in the column
header used for sorting; it points upward to indicate an ascending sort and downward for a descending
sort. A sorted bank can be saved in its state if needed.

11.12.2  Searching the memory bank

New bank N Frequency S  Mode Description SubM Filter Por +
Open bank

Save bank

Save bank as...

Import »

- )

Select banks folder

Hide files pane L Nex LT I I Match case

Filter by VRX freq.

Sometimes you might have to search a large bank for a specific word occurrence. To activate the search
function choose Find... from the context menu; a search footer appears. The search footer provides you
with familiar functions to perform incremental search; as you type your text in the search edit box the
search process refines. Use the Next-Previous buttons to navigate among multiple occurrences of the
same word. Unless the Match case option is checked search is case-insensitive.

11.12.3 Selecting and copying multiple cells

It is possible to copy multiple cells at a time; to perform a multi-cell selection click on the upper left cell and
drag to the right lower cell of the selection area (selected text turn to yellow). Then you can copy and
paste the entire selection using the clipboard shortcuts already seen (CTRL+C, CTRL+V).

11.12.4 Creating a composite bank from several source banks

You can copy-paste from the Memory Panel of a given SDRuno instance to the one of another instance;
this capability allows complex editing operations like the composition of a bank including data from
different “source” banks, without the need of a specialized tool. You only need another Memory Panel
from a second SDRuno instance. Simply apply all the editing operation already seen but this time using
one Memory Panel instance as the source and the other as the destination.
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11.13 Filtering data

New bank 7 Frequency S  Mode Description SubM Filter Port

Open bank
Save bank
Save bank as...
Import
Eind...
Select banks folder
Hide files pane
l-l | Filter by VRX freq.

Filtering a data bank means showing only the rows that match filtering criteria. Currently you can only
filter by VRX frequency. To enable this options choose Filter by VRX freq. from the context menu. The
data grid is updated after every frequency change; since filtering a large data bank is a CPU intensive
operation, the program waits until it detects that the tuning operation has ended, and then performs the
filtering. If no VRX is assigned to the Memory Panel, no filtering occurs. Filtering is disabled when
choosing one of the following options:

- New bank
- Import
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For more information contact support@sdrplay.com

12. LegalInformation

Redistribution and use in source and binary forms, w ith or w ithout modification, are permitted provided that the follow ing co nditions
are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.

2. Redistributions in binary formmust reproduce the above copyright notice, this list of conditions and the follow ing disclaimer in the
documentation and/or other materials provided w ith the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products derived
fromthis software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMTED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SDRPlay modules use a Mirics chipset and softw are. The information supplied hereunder is provided to you by SDRPlay under
license from Mirics. Mirics hereby grants you a perpetual, w orldw ide, royalty free license to use the information herein for the
purpose of designing software that utilizes SDRPlay modules, under the follow ing conditions:

There are no express or implied copyright licenses granted hereunder to design or fabricate any integrated circuits or integrated
circuits based on the information in this document. Mirics reserves the right to make changes w ithout further notice to any of its
products. Mirics makes no w arranty, representation or guarantee regarding the suitability of its products for any particular purpose,
nor does Mirics assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any and
all liability, including without limitation consequential or incidental damages. Typical parameters that may be provided in Mirics data
sheets and/or specifications can and do vary in different applications and actual performance may vary over time. All operating
parameters must be validated for each customer application by the buyer’s technical experts. SDRPlay and Mirics products are not
designed, intended, or authorized for use as components in systems intended for surgical implant into the body, or other applications
intended to support or sustain life, or for any other application in w hich the failure of the Mirics product could create a situation w here
personal injury or death may occur. Should Buyer purchase or use SDRPay or Mirics products for any such unintended or
unauthorized application, Buyer shall indemnify and hold both SDRPlay and Mirics and their officers, employees, subsidiaries,
affiliates, and distributors harmless against all claims, costs, damages, and expenses, and reasonable attorney fees arising out of,
directly or indirectly, any claim of personalinjury or death associated with such unintended or unauthorized use, evenif such claim
alleges that either SDRPlay or Mirics were negligent regarding the design or manufacture of the part. Mirics FlexiRF™, Mirics
FlexiTV™ and Mirics™ are trademarks of Mirics .

SDRPlay is the trading name of SDRPlay Limited a company registered in England # 09035244.
Mirics is the trading name of Mirics Limited a company registered in England # 05046393
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